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Service Packs Explained (and needed)
Although most of us still think of Windows 7 as a brand new operating system, it is, in fact,
starting to show its age. Windows 7 made its debut on October 22, 2009. Is one and one-half
really old? Well, in the computer world, it is not old, but it is certainly full-grown. One sign of
this is that Microsoft has just released the first Service Pack for Windows 7.
A service pack is a collection of updates, bug fixes, and enhancements for a software
program. As you know,
Microsoft routinely offers updates for
their Windows operating
systems. These updates come out
weekly and they patch or, you
might say, repair the operating system
so that they remain safe from
hackers. They can also include
improvements or
enhancements to the operating
system. At a certain point in
time, Microsoft gathers all of those
updates, adds any other
updates and enhancements they have
and issues this batch of
updates as a service pack. It is also
important to note, that when
Microsoft issues a service pack, this
service pack also makes sure
that all of the updates and
enhancements work well together and offer good stability for the operating system.
The question that I am most often asked is this, "If I have installed every update that
Microsoft has released, do I still need to install the service pack?" The answer is "yes." Often
the service pack contains additional updates and/or enhancements that were not included in
the weekly updates. Also, a service pack makes sure that all of the updates are put together
properly to make your system run well.
In fact, Microsoft thinks that this is so important that they only support the operating system
when it has the proper service packs installed. Each service pack should be installed when it
is released. If, for some reason, they are installed all at the same time, each is installed
sequentially.
So, for Windows XP you should have Service Pack 3 installed. Windows Vista should have
Service Pack 2, and Windows 7 should have Service Pack 1. To learn what service pack you
have installed, just click on the Start button, right-click on Computer or My Computer, and
then click Properties. You will see the service pack listed under the Windows edition.
You can go to the Microsoft website and install a service pack from there, if you happen to be
missing one. All service packs from Microsoft are free. If you are using Window 7, the new
service pack will be offered to you through Microsoft's automatic update service. This
Windows 7 service pack can take up to 30 minutes and will re-boot your computer. I have
installed Window 7, Service Pack 1 on several computers without a problem, but you should
be aware that installing a service pack is a big update. Microsoft recommends that you back
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up your computer before installing a service pack. And to be honest, you should be backing
up your computer anyway. So if you don't have a backup strategy in place, this is a good time
to implement one.
The newest version of Internet Explorer - IE 9 was released March 14. This is by far, the best
version of Internet Explorer that Microsoft has ever released. IE 9 won't run on Windows XP;
it requires Windows Vista or Windows 7. Although Microsoft is not requiring Windows 7
Service Release 1 to install IE 9, it is advisable to install this Service Release before you
install IE 9.
Service Packs are a fact of life for Windows users. Installing them may be a bit of a pain, but
you really need them to make sure that your Windows system is secure and stable and that it
performs well.

Cell Phone Lingo
By Wil Wakely, President, Seniors Computer Group, CA
March 2011 issue, Bits and Bytes
www.scgsd.org / willw (at) adnc.com

When it's time to buy or upgrade to a new cell phone, are you as confused as I am with all the
fancy terms and acronyms in the sales pitch? They make my head spin. Some of the terms
you will encounter refer to the technology generation of the phone, as in G0 to G5. About
every 10 years the next larger G (generation) number appears denoting a major improvement
in cell phone technology. Each generation improves the speed, security, power usage, range
and reliability of cell phones.
G0 refers to the original mobile telephone, a large unit stored in the car trunk with a hand-set
between the driver and passenger seat. Remember those? Essentially it was a souped-up
short-wave radio. These first made the scene via Motorola and Bell Telephone in the 50's.
Next came G1 using GMS tech (see below) which also was analog, first introduced in Japan
in 1979 and later in the USA in 1983. In 1992, G2 was a major improvement using digital
technology vs. analog that was used in G1. So what's the difference? Analog is a continuous
smooth signal like whistling a tune. Digital rapidly samples the song and converts each small
time segment into a series of ones and zeros, or digits. Through some clever complex
calculations, these digits are converted back to the original sound tone and volume. The
advantages of digital are that the data can be compressed and encoded for security and no
information is lost as long as the 1/0 signal can be detected, even from a lot of accompanying
noise.
In 2001, 3G was introduced using a new technology called CDMA (code division multiple
access) developed by our local Qualcomm company. This is a very complex encoding that
allows many more users on the same channel at the same time. G3 is probably the most
common system in use today.
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G4 arrived in 2006 and allows 1 Gbt/s (one gigabit per second) downloads from a fixed
location or 100 mbt/s (megabits per second) from a moving vehicle. These high speeds allow
streaming high-definition video (HD movies) on your cell phone. Also, connections to the
Internet are faster and better. G5 is still in the lab and promises even more features, but may
not arrive before 2020.
The cell phone field is rampant with 3, 4, and 5 letter acronyms. Here are a few that a
salesman may try to impress you with:
!
!
!
!

GMS (global mobile system): still widely used in older phones.
TDMA (time domain multiple access): sharing the airwave in small time slots.
FDMA (frequency domain multiple access): sharing the airwave in different frequencies.
CDMA (see above).

An analogy to the problem of multiple access is a room (channel) in which people wish to talk
to each other simultaneously. To avoid confusion, people could take turns speaking (time
division), speak at different pitches (frequency division), or speak in different languages (code
division). Other terms you may encounter are LTE (long term evolution), OTDMA (orthogonal
TDMA) and WiMax (similar to WiFi). These are fancy names for some of the latest
improvements in the field. So the best strategy for buying a new cell phone is to read the
reviews and then find a salesman you can trust. Some of
the above information may help you understand his pitch and also impress him with your
knowledge.

Powermat
Reviewed by George Harding, Treasurer, Tucson Computer Society, AZ
March 2011 issue, TCS eJournal
www.aztcs.org / georgehardingsbd (at) earthlink.net

You probably carry at least one portable device, a
mobile phone. To keep it charged, you need a charger
for a home outlet or one for the car. When you travel,
either locally or away from home, you must remember
to carry one or both of these chargers. It's
cumbersome, but that's the price of a mobile device.
Or maybe not! Powermat has a solution for any of your
mobile devices, and it doesn't require a charging cord. How do they do this? You charge a
Powermat unit, then carry it with you wherever you might be.
Just set your mobile device on one of the panels of the Powermat and your device is charged
wirelessly by induction. What does that mean? You don't need to know. It just works.
I received a Powermat for evaluation. It is a small 3" X 3" tri-fold device. It unfolds into three
connected panels, two of which are charging panels. The third section is the storage battery
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that allows the device to be used wirelessly.
You first charge the Powermat with a wall outlet. Then fit your mobile phone or other device
with a receiver tailored for your specific type of device. Then simply place the mobile device
on the Powermat. You'll hear a beep to indicate that connection is made and that your mobile
device is charging. Another beep sounds when your device is removed.
The tri-fold Powermat I received is one of several styles available. Some are smaller, some
come with a Power Cube, a unit that connects to your mobile device and is what is placed on
the Powermat.
I tried out my wife's Blackberry on the Powermat. The unit comes with a Power Cube which
you connect to the Blackberry, then place it on the Powermat to charge. The Power Cube is
about one and a half inches square and has a white, smooth surface.
One corner of it has a wire attached with a connector with adaptable heads for almost any
receptacle available today.
The wire fits neatly into a groove around the edge of the Power Cube when not in use.
I also received a receiver for my iPhone. A receiver is a shell into which the iPhone fits. It has
a compatible plug in its base and a unit on its back similar in function to a Power in function to
a Power Cube. Once the iPhone is in the receiver, you need only place it
on the Powermat to charge it.
Powermat announced at CES an agreement that will provide wireless charging capabilities in
airports, through the installation of Powermat units in terminal seating. Airports are difficult
environments in which to obtain recharges. This solution will benefit the many travelers with
mobile devices that need charging in an airport. In addition, Powermat will be working with
GM to incorporate in their cars, starting with the Chevy Volt, a charging solution for most
mobile devices, without the use of wires.
About: Powermat
Vendor: Powermat
www.powermat.com
Price: tri-fold $130, receiver $40

Smartphones (Part 2) Control and Interaction
By Phil Sorrentino, President, Sarasota PCUG, Florida
March 2011 issue, Sarasota PC Monitor
www.spcug.org / president (at) spcug.org

The smartphone doesn't have a mouse to let you push a pointer around the screen, so then,
how do you control the interaction? The smartphone has a touch-sensitive screen which
interprets movement of a finger (or fingers) on the screen. A whole new set of "gestures" or
touch controls have been developed. Some of the new gestures are the "flick," and the
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"pinch". The flick is done with one finger and its quick movement indicates the intended
operation, like turning a page. A pinch is done with two fingers and is typically used to enlarge
or shrink something on the screen. Mostly, you use
your finger to point to things that you want done.
Another gesture or interaction is to "Select an Icon"
for movement. To do this, you Touch and Hold the
Icon. After holding it for a second or two, the App will
be selected and you will receive feedback. On the
Droid2, the feedback is called haptic feedback,
which means you get a slight vibration on the
touch-sensitive screen. On the iPhone, the icons on the page begin to
wiggle.
Applications or Apps are what you use to get things done. Some common and very useful
Apps are Contacts, Calendar, Places, Maps, Mail (Yahoo or Google), Notes, Time & Date,
and Browser. There are also Apps for YouTube. Skype and Kindle. The Kindle App turns
your smartphone into a reader that has access to the Kindle (Amazon) library of books, many
of which are free.
There seems to be an App for almost anything that you would like to do with your
smartphone. (If you don't find an App for something you want to do with your phone, maybe
you can invent one. There is always some software programmer willing to take on an
interesting challenge.) In addition to Apps, there are a myriad of games available for the
smartphone, many of which are free. For android devices, Apps and games are found at the
Android Market. (iTunes is used by the iPhone.)
The Market is an App that comes with the phone. To get something from the Android Market,
just touch the Market App Icon and you will immediately be at the
front door of the Market. Here you can choose from Apps or
Games or a selection that is presented on the opening screen. If
you choose Apps, you can then choose to review all Apps or only
the Free Apps. (The same is true for Games.) Once you find an
App or game you are interested in you just touch it and if it is free,
it will be downloaded to your smartphone. If there is a cost, you will
have to set up an account so that your credit card can be charged. Most of the Apps that are
not free are under $10.
All of the Apps on your smartphone are installed and available in an All Apps area, which
slides out onto the current home screen. (Android devices have multiple homescreens.) On
the Droid2 this area is accessed by pressing an Icon at the lower-center of the display screen.
So after you have decided how to use your home screens, you can put an App there by
finding it in the All Apps area and then Touch and Hold the desired App icon. When the App
is selected and ready to be placed, you will get feedback and the App will appear on the
home screen that was below the All Apps area. Apps can be moved between home screens
by Touch and Holding the App and waiting for the feedback, then moving the App in the
direction of the home screen that will be the new home screen for the App. On Android
phones, an App can be deleted from a home screen, but not from the All Apps area, by
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Touch and Holding the Icon and then moving it to a red trash can that appears at the bottom
center of the display.
When you want to use an App, you just touch it and it starts to perform. You will see the Icon
spring into action, attempting to provide its functionality. Once started, other options may be
available from a menu by touching the Menu button. (On the Droid2, the Menu is in the lower
left, below the display screen). For example, if you touch a Contacts App, it will display your
list of contacts. When you find the contact of interest, a touch will display all the information
relating to that contact. Touching the Menu button gives you options to Delete or Edit the
contact.
With all these Apps and a pretty small screen it would be nice to be able to organize your
Apps; so, unlike most computers, the Droid2 has 7 home (display) screens, arranged
horizontally. You expose another home screen by flicking your finger on the touch-sensitive
home screen in the direction of the screen desired. For example if you are on home screen
#4, the middle home screen, and you want to go to home screen #3, you would flick to the
right. To go to home screen #5, you would flick to the left. Multiple home screens make it
easy for you to organize your Apps. Apps that you think work together can be collected on a
particular home screen. You could have a home screen for entertainment, one for work, one
for family, another for sports. Any organization of Apps that makes sense to you would be
appropriate.
This only scratches the surface of the features, interface techniques, and usefulness of a
smartphone. Future articles will concentrate on some of the more interesting features, but I
think you will now agree that:
Smartphone == PDA + (not so smart) phone.

Free Comic Books Online
By Ira Wilsker, Member, Golden Triangle PC Club, TX; Columnist, The
Examiner, Beaumont, TX; Radio Show Host, Mondays, 6-7pm CT, KLVI.com
iwilsker (at) sbcglobal.com

http://www.techsupportalert.com/free-books-comics
http://www.bbc.co.uk/cult/buffy/ecomics
http://borderwalker.com
http://www.comicweb.com/goldenage_comics.htm
https://read.dccomics.com/comixology/#/free_comics
http://digitalcomicmuseum.com
When I was a kid growing up in the 50's, I enjoyed buying and reading comic books. While
most of them were a dime, some were expensive at a quarter. My dad acquiesced and when I
with him to the drug store to buy funny comic books that he approved, such as Little Lulu. My
mom gave in if I wanted to buy any of the classic comic books, which were literature
transformed into a comic book format. Some of my elementary school teachers decried comic
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books as the ruin of my generation, and confiscated them in wholesale quantities from me
and my classmates, probably to surreptitiously read in private and to trade with the other
teachers for their stash of contraband. Today, with the internet, video games, and other forms
of entertainment, contemporary comic books are not as popular or as widely available as in
the past. For present and former comic book aficionados, there are now free online resources
that allow some of us to relive our long lost juvenile days, and to also allow today's
generations to experience the joys that I enjoyed decades ago.
One of the top free software information websites, Gizmo's Freeware (techsupportalert.com)
recently published a directory and reviews of the top free online comic book repositories
(techsupportalert.com/free-books-comics). Gizmo made it a point that the listed sites were not
pirate websites displaying illicit copies of copyrighted content, but instead were totally
legitimate websites with totally legal content.
The first listed site that I visited displayed the first issue of Action Comics, dated June, 1938,
which is the issue that introduced Superman to the world. According to Gizmo, a copy of this
issue sold recently for $1.5 million, but anyone can view it online for free.
One of my adult daughters is a fan of the TV version of "Buffy the Vampire Slayer", and would
probably find the 11 "e-comics" posted online by the BBC most interesting
(bbc.co.uk/cult/buffy/ecomics). BBC has also posted several of the "Dr. Who" comic series
online at www.bbc.co.uk/doctorwho/s4/misc/fiction/writerscomics for those who like the
popular TV show of the same name.
"The Comic Web" at www.comicweb.com/goldenage_comics.htm has over 30 full-length
comics from 1936 to 1955 that can be viewed online for free, and downloaded as a PDF for
only a dime. Captain Marvel #1 " Captain Marvel Battles the Vampire" from 1941 started a
cult classic, and can be viewed online at
www.comicweb.com/onlinecomics/captain_marvel_01_story.pdf. Other Comic Web holdings
include a few of the World War II series of super hero comics "Fighting Yank" where the
super hero, wearing a cloak and tri-corner hat
reminiscent of 1776 takes on the axis powers. On the
bottom of each "Fighting Yank" page is a patriotic
statement of the day, encouraging the reader to buy
war bonds or to contribute to the scrap drives to
defeat the axis. Considering the date of publication
and the then contemporary events in the news, it is
obvious how the "Fighting Yank" would appeal to the
children of the day. One of the oldest comics on the
Comic Web page is "Detective Picture Stories #1 Bogus Bills" from 1936. "GI Joe #10" from 1950,
reflects some of the sentiments from early in the
Korean War, where the U.S. soldiers have to deal with
the likes of an attractive female reporter while dealing
with a "Russky tank". While patriotism is a common
theme of many comics of the period, what may be the
epitome of a patriot super hero may be the 1941
rendition of "The Flag" who is the adopted son of a
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crippled war hero, and has the speed of the wind, and the strength of a hundred men. In his
red, white, and blue uniform he takes on the enemies of America. In Our Flag #3, The Flag
removes a flag bearing the swastika from the dome of the capitol building, and defeats the
enemy who has torn down the American flag from the Capitol building; in just16 pages, The
Flag saves the country. While not as dramatic, in the 1941 comic book "Stars and Stripes #4"
another super hero, the Iron Skull, saves a convoy of ships from marauding U-Boats. While
historically inaccurate, comics like these can be used to demonstrate some of the popular
ideas and philosophies of the day, and show how those contemporary super heroes dealt with
the pressing issues facing the country.
DC Comics, one of today's predominate comic book publishers,
has been publishing comic books since 1934. In addition to
producing print comic books, DC Comics has made available a
large collection of free comics online at
read.dccomics.com/comixology/#/free_comics. With new titles
added frequently, DC Comics has an impressive collections of
comic books available. In Superman Confidential #1 (January
2007), the secrets of Kryptonite are explained; for those who may
be unaware of the Superman saga, Kryptonite is a strange mineral
from the defunct planet Krypton, that has the unique power of
sapping Superman's legendary strength, depriving him of his super
powers. In a two-page teaser to encourage the reader to purchase
the full comic, DC Comics online has "The Origin of Robin", the
super hero that becomes the famous sidekick of Batman. Other
super hero comics included on the free DC Comics website, consisting of either teasers or full
editions, are the likes of Justice League of America, Wonder Woman, and the Green Lantern.
One of the largest libraries of online comic
books is the Digital Comic Museum
(digitalcomicmuseum.com) which has over
6000 comic books available for free download
(free registration required). On this website I
found many of the comics that I enjoyed as a
child. The date ranges of the comics at the Digital Comic Museum are from 1902 to 1986.
Some of the larger collections sorted by publisher on this site include Charlton Comics with
650 issues; American Comics group (493); Better/Nedor/Standard/Pines Publications (410);
Comics House Publications (445); Dell Comics (517); Quality Comics (1243); and Fawcett
Comics (1120 issues). Many old classics are available, including such oldies as The
Katzenjammer Kids and Little Orphan Annie. There is even a comic book available that was
published and distributed by the U.S. Government, "Burt the Turtle Says Duck and Cover";
we were provided a copy of this exact comic book in elementary school where it was
mandatory that we read it in class, and then practiced our "Duck and Cover" drills that were
supposed to protect us from a Soviet nuclear missile strike. The user should be aware that
many of the comic books available for free download from this website are compressed with a
variety of compression methods, so that a free universal decompression utility such as
PeaZip (peazip.org), or 7-Zip (7-zip.org) may be necessary to prepare the files for viewing.
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There are many other websites listed by Gizmo that have free comic books to view and
download. With free resources such as these, it is easy for some of us to relive our childhood,
while others may discover a forgotten but very entertaining resource.
Ira Wilsker is a member of the Golden Triangle PC Club as well as Director of the
Management Development Program at Lamar Institute of Technology, in Beaumont, TX. He
also hosts a weekly radio talk show on computer topics on KLVI News Talk AM560, and
writes a weekly technology column for the Examiner newspaper <www.theexaminer.com>. Ira
is also a police officer who specializes in cybercrime, and has lectured internationally in
computer crime and security.

Tech Support Computer Humor

Tech Support: What kind of computer do you have?
Customer: A white one.
...............................................
Customer: Hi, this is Celine. I can't get my DVD out!!!
Tech Support: Have you tried pushing the button?
Customer: Yes, I'm sure it's really stuck.
Tech Support: That doesn't sound good; I'll make a note.
Customer: No, wait a minute, I hadn't inserted it yet. It's still on my desk … sorry. Thank
you.
..............................................
Tech Support: Click on the 'MY COMPUTER' icon on the left of the screen.
Customer: Your left or my left?
...............................................
Tech Support: Hello. How may I help you?
Male Customer: Hi … I can't print.
Tech Support: Would you click on 'START' for me and .. .
Customer: Listen pal; don't start getting technical on me. I'm not Bill Gates!!!
..............................................
Customer: Good afternoon, this is Martha. I can't print. Everytime I try, it says . . . 'CAN'T
FIND PRINTER.' I even lifted the printer and placed it in front of the monitor, but the
computer still says it can't find it!!!
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7 Little Word Annoyances and Their Easy Fixes
By Nancy DeMarte, Columnist, Office Talk, Sarasota PCUG, Florida
March 2011 issue, Sarasota PC Monitor
www.spcug.org / ndemarte (at) verison.net

Below is a collection of frustrating things that can happen when using Microsoft Word. These
annoyances can occur in any version of Word although most are geared to Word 2007 and
2010. In Word 2003, the fix-it steps may be different.
Annoyance 1: You accidentally press the Caps Lock key on your keyboard before typing a
paragraph. When you finish, you find everything in capital letters.
The Fix: Rather than retyping the whole paragraph, highlight the text, then click the "Change
Case" button (Aa), located on the Home tab in the Font group. Click "Sentence case" to
transform your paragraph into normal sentences.
Annoyance 2: You create a party invitation with a light blue background (Page Layout tab Page Color). But when you print it, the background is white.
The Fix: Office has set Word to not print full page background colors, probably to save users
from wasting ink. You can, however, make the colored background print. Click the Office
button, then Word Options -- Display. Put a check mark next to "Print background colors and
images," then click OK. Until you remove this checkmark, all colored backgrounds will print.
Annoyance 3: You're working on a document where you've set the text size to be a fairly
small 10 points. But you find that the text is too small to view comfortably while you're typing.
The Fix: Drag the Zoom slider located in the bottom right corner of the Word window to the
right to enlarge the screen view of the text. When printed, the text will be 10 points no matter
how big it appears on the screen.
Annoyance 4: You find that the spaces between lines of text in your document are wider
than you want.
The Fix: If all the spaces are wider than expected, you can change the line spacing for the
whole document at once. On the Home tab, in the Editing group, click Select -- All to highlight
all the text. Next click the Line Spacing button in the Paragraph group and select 1.0 for
single-spacing or one of the other choices.
Note: Word will not remove extra space after paragraphs when you choose a line spacing
size. To remove extra space after a paragraph, select the paragraph before the extra space,
click the Line Spacing button and choose "Remove Space After Paragraph." A more
permanent way to create no extra space between paragraphs is to open the Paragraph group
dialog box launcher (small diagonal arrow) on the Home tab and put a checkmark in front of
"Don't add space between paragraphs of the same style."
Annoyance 5: Every time you type an email or web address into a document, it turns into a
clickable hyperlink with underlined blue text, even if that isn't your intention.
The Fix: The quickest fix is to right click the address and select "Remove Hyperlink." But this
is only a one time remedy. To remove this action permanently, click the Windows button, then
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this sequence: Word Options -- Proofing -- AutoCorrect Options -- AutoFormat As You Type.
Remove the checkmark next to "Internet and Network paths with hyperlinks" and click OK.
Annoyance 6: You find that as you type, distracting wavy red and green lines show up under
words and phrases.
The Fix: Word is set to check spelling (red lines) and grammar (green lines) as you type.
This is another Proofing option which comes enabled from the factory. To turn off one or both
of these features, go to Word Options (Office button - Word Options) and click Proofing.
Remove the checkmarks next to "Mark grammar errors as you type" and "Check spelling as
you type." You can always check spelling and grammar after your document is complete by
clicking Spelling & Grammar at the left end of the Review tab.

Several of these fixes involve the settings found in the Options area of the Office 2007 menu
(File menu in 2010). Options are available for all the Office programs (Word Options, Excel
Options, Access Options, etc.) These default settings were determined by interviews with
thousands of people who use Office regularly in the workplace. If you find that the factory
settings are causing you more trouble than help, changing them is a simple task. All Office
users should take a personal tour of the Options menus, which resemble this Word Options
window with the AutoCorrect box open:

Annoyance 7: You often save documents to the same folder which is buried within other
folders in My Documents. It takes several clicks to find this folder each time you want to open
or save a document to it.
Fix 1: You can find almost any folder on your Windows Vista or 7 computer by typing its
name into the Start Menu search box just above the Start button. Often it takes only a letter
or two before the folder appears in the search results. On the downside, you have to do this
each time you want to open the folder.
Fix 2: A way to make any folder immediately available is to add it to the Favorites section of
the navigation pane. This pane appears on the left side of any explorer window where you are
viewing, opening or saving files and folders. To make a folder a Favorite, start by creating or
opening a file, like a document, and click Save As, which opens the Save As dialog box. This
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reveals the navigation pane on the left, showing a list of possible places to save the file.
Navigate to the folder you want to make a favorite so that it is the last item in the history bar
across the top. Then right click the word Favorites in the left pane. From the drop down
menu, click "Add current location to Favorites." Your special folder will now appear in the
Favorites list. It will also appear in the Favorites list of the other MS Office programs on your
computer, such as Excel and PowerPoint. To remove a folder from Favorites, right click the
folder and select Remove.
Using a computer should be fun as well as useful. Take a few minutes to think what your
personal computer annoyances are and try to find fixes for them. Customizing your programs
makes using the computer much more enjoyable and efficient. ??

“The technician set up my laptop, now what do I do?”
By Gregory West, Member of the Computer Operators of Marysville and
Port Huron, MI, and Sarnia Computer User Group, Canada
http://gregorywest.wordpress.com/
prospector16 (at) gmail.com

Ah, the wonderment of getting a new computer. No more having to watch
others show off their computer skills as they demonstrate their new digital
slide show, or listen about how they talk with relatives across three oceans
for hours at no cost. With your new computer you are ready to join the
online communities around the globe.
Three gigabytes of random access memory, 500 gigs of hard drive, a one year subscription to
some antivirus / malware protection software utility and you are "good to go," says the clerk in
the computer store.
"But does it come with a manual," you ask?
"The manual is in the OS software," the clerk says as he gets you to sign his copy of the
credit card slip. "Have a nice day," he hollers as you lug the computer through the doors
towards home.
"Ya right," you mutter under your breath
So many choices, too many decisions, but at least you finally get it home. Once you open the
lid and go to turn on the new computer you realize that you have no idea what you are doing.
In fact, you don't know a gigabyte from a Tyrannosaurus Rex, and you couldn't care less. All
you want is to go on the Internet and check your email, surf some websites and maybe learn
how to get those 265 photos from your digital camera.
"So now what," you say aloud to yourself? "Where do I begin," you ask your dog in
desperation as she gives you that puzzled look.
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There is an easy way to learn the various computer functions you need to catch up with your
computer geek of a neighbour. First, you can take a formal course at your local college.
These courses usually range from beginner to advanced. You can also take online courses
(courses offered over the Internet), but this takes a special skill, as many people are not used
to working alone and need to get out into a classroom set up with real humans. You can also
join a local computer group. Here you will find people with similar interests who provide
various seminars on tech-related issues.
I have been on a computer since 1972 where an IBM System/360 Operating System was the
popular system in data processing centres. Over the years I have received computer training
from all methods mentioned about. In fact, today I am taking two computer courses from
books that came with DVD training programs
However, if you simply need to know one certain function on the
computer, learn a software program, or how to troubleshoot a problem
in your computer, I suggest Google's YouTube videos. Computer
instructors, tech companies, libraries, schools and many knowledgable
individuals upload training videos to YouTube. Here you not only get
free training, but targeted training. For instance, if you need to know
how to install a USB flash drive in Windows 7, you simply go to
youtube.com on the Internet and there will be many videos to help you
through this process.
One tip for searching within YouTube for help, try using the term: "tutorials" with your search.
Sometimes this will give you a full training course on the particular subject you are interested
in learning. I use YouTube all the time when I need help with a particular computer program.
But it doesn't stop there either. I wanted to learn how to winterize my RV and save the
hundred dollar fee, so I searched for videos on YouTube and have winterized my own trailer
ever since for only the cost of antifreeze
Gregory West is a Mac Instructor for Lambton College. He is also Webmaster at Central
United Church, the home of Sarnia's new Community Computer Training Centre at:
http://goo.gl/76H15. This is free and open to the public as a community service. Learn at your
own speed.

From Ray Nichols
If you have items you would be willing to donate for our club drawings, they will be
gratefully accepted. Be sure to wear your name badge for the drawing.
Please also remember to bring your used magazines, books, videos, DVD's, and
cassettes for distribution to Veterans in our area. If you have old household or device
batteries, or used CFL (Compact Fluorescent Lamp) bulbs, bring them for legal recycling
(it is against the law to dispose of them in the trash). Old Cellphones can be converted to
Telephone Calling Cards for overseas Military Personnel. Old eyeglasses will be turned
over to the Lions Club for reissuing to needy people
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Smart Computing Tips
www.smartcomputing.com

Animate Menus
You can animate the drop-down menus for FrontPage, Word, and Access. To do this,
right-click any visible toolbar and then choose Customize from the shortcut menu. In the
Customize dialog box, click the Options tab. Click the Menu Animations drop-down arrow and
then choose an effect (such as Slide or Unfold) from the list. Click Close to confirm your
choice and use the menu animations.

Save Space
Some of us have small, cramped workstations, where our monitors eat up most of the desk
space. Some of us have plenty of room, but simply want a clutter-free desk. Whatever the
reason for wanting to clean up your desk space, a trackball mouse is an excellent,
comfortable way to do it. A trackball directs the mouse pointer using an external ball that sits
in a socket with sensors that detect the ball’s movement. The ball is moved with the user’s
thumb, while the rest of the hand rests over the right and left click buttons and across the
scroll wheel. Because the trackball doesn’t need a flat surface on which to roll mechanically
or with a laser, there is no need to take up desk space with a mouse pad. The trackball sits in
one position while your thumb moves the mouse pointer. The space-saving mouse style is
also useful for generally cramped working areas such as airplanes or coffee shop tables.

Quickly Enter A URL In IE
When you manually enter a URL in Internet Explorer, it can be a hassle to use your mouse to
select the address bar, highlight the URL, and delete the current Web address. To expedite
the process, press F6 on your keyboard and your cursor will automatically move to and
highlight the current URL in the IE address bar. Because highlighted text is automatically
deleted if other text is entered, you can simply type your new URL in the IE address bar.

Turn Off Your PC To Save
You don’t work 24 hours a day (hopefully), so there’s no need to leave your PC on all day. In
addition to shutting your computer down at the workday’s end, use standby or hibernate
settings if you frequently step away from the computer throughout the day. As a rule, set
these modes to kick in after 15 or 20 minutes of inactivity. Set the hard drive to hibernate
after 30 minutes of nonuse. If you’re using a screen saver, turn it off. Designed to lengthen
the life of old CRT displays, screen savers aren’t necessary with newer flat-panel LCDs.
Some screen savers also draw on the graphics card, monitor, processor, and hard drive to
function.

Online Radio
If you’re tired of listening to your MP3 player or the set of CDs you have lying around your
desk, try an online radio station. There’s a variety of free Internet radio stations, so you can
select a format that’s both entertaining and helps you focus on work. One of our favorites it
Pandora, which suggests songs you might like based on the songs or artists you tell Pandora
to play. www.pandora.com
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The Club’s
Meeting Place

Need help hooking up
that new PC,
or installing DSL-Cable?
Call Jim Goodman, $60.00 for as long
as it takes.579-0122
jgood99@sbcglobal.net
Modesto, Ceres Area

Our general meeting and the Random
Access Special Interest Group are held at
the Denny’s at 1525 McHenry Avenue
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Modesto PC User Group Officers
President
Program VP
Secretary
Treasurer
Director-at-Large

Mike Kumler
Jim Goodman
Terry Fix
Barbara Cameron
John Selover

531.2262
579.0122
524.8062
522.1389

president@mpcug.net
sig@mpcug.net
secretary@mpcug.net
treasurer@mpcug.net
dal@mpcug.net

Appointed Positions
SIG Coordinator
Press Relations
Membership
Webmaster
Editor

Jim Goodman
Elizabeth Leedom
Hank Mudge
Jim Goodman
Judy Taylour

579.0122
523.4218
529.1936
579.0122
661.252.8852

sig@mpcug.net
programvp@mpcug.net
membership@mpcug.net
webmaster@mpcug.net
scvjudy@usa.net

PC Post
Editor Emeritus: William “Doc” Holloway – 1920-1996
Editor Emeritus: Claude Delphia
President Emeritus: Bud Bondietti – 1950 - 2008

Join The Modesto PC User Group
To join MPCUG (or just get more information about us, go to our Website and fill out the new
member form or mail your check to: MPCUG, P.O. Box 5122, Modesto, CA 95352-5122.
Membership is just $24 a year and includes 12 issues of the PC Post along with participation
in all meetings and events. You will also receive E-mail advising you of extra events or news.

The PC Post and Editorial Policy
The PC Post is published online 12 times per year and is available to all group members as a
membership benefit. Annual group membership dues are $24.00. Opinions expressed in PC
Post do not necessarily reflect the opinions or views of the members as a group or the Board
of Directors. The PC Post encourages group members to submit articles for publication. We
would like to have articles which deal with the writer’s experience with computer hardware
and software or digital photography. An article may deal with any computer-related subject
provided it contains no libelous or offensive material. We can’t use information copied from
other publications without written permission except for quotes. Articles should be submitted
in unformatted MS Word or RTF text. Proofread and run your spell checker; watch for special
upper and lower case in brand names. If you want to include a graphic, please send it as a
jpeg attached to the E-mail submitting your article. Please note in the article where the jpeg
should be placed. We reserve the right to edit articles for length or to improve readability.
Longer articles may be published in several parts. We will not knowingly promote unlicensed
businesses. Letters to the editor are encouraged. All articles and letters to the editor should
be submitted to the editor via E-mail as an attached file (Word or rtf). Please include your
name, day and evening phone numbers.

